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INTRODUCTION 

This workshop is designed to provide instruction on how to organize a course’s content, prepare course 
content for use in an online course, and manage content within Laulima. 

This learning guide is intended to serve as a reference upon the completion of the module. 

GOALS 

After this workshop is complete, the user will know how to: 

 Determine the best tool for delivering content to students 
 Organize course content by creating a file structure 
 Convert files for use online 
 Manipulate content within Laulima 

UNIT 1: USING CONTENT ONLINE 

Online course content can consist of a number of pages of content such as lecture notes, multimedia 
presentations, assignments, and quizzes. Your course files can include:  

 Text files 

 HTML (Hypertext Markup Language) files 

 Multimedia files, such as Impaticized PowerPoint presentations, Acrobat PDF (Portable Document 
Format), Podcasts, etc. 

There are a number of ways to use content in Laulima: 

 Create, or cut and paste, content into Laulima’s built-in HTML editor (preferred method because it is 
immediately viewable by students with no downloads or redirects). 

 Link to content located in Resources. 

 Link to an outside website. 

You can organize these content pages structurally in a Table of Contents-type layout that provides students 
with a guide to the learning pathways for the course. The hierarchical structure also makes it easier for 
students to find specific course content. This structure can be accomplished one of two ways: 1) using the 
Module tool or 2) using Resources. There are some pros and cons to each strategy: 
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UNIT 2: PREPARING TO USE CONTENT ONLINE 

The first thing to do is capture your ideas using storyboarding or a hierarchical chart. Storyboarding is the act 
of laying out all of your course’s components (i.e., syllabus, objectives or learning pathways, assessments, 
etc.) and knowing where everything is going to be placed, what content you’ll need and where it’s coming 
from, etc. Here’s an example: 

Capability Module Tool Resources Area 

The learning pathway is 
automatically set-up in a Table 
of Contents-type format during 
structure development 

Yes. After the module is added, 
content is added as sections within 
the module. 

No. Instructor will need to set 
up the file folder(s) and place 
the content inside the folders in 
desired order (order is 
alphabetical by default). 

Automatic availability can be set 
with a start and end date/time. 

Yes Yes 

Instructor can easily tell the 
students what to do next when 
they finish the objective or 
module. 

Yes. The module tool provides a 
“next steps” feature. 

No. The instructor would need 
to create a file that explains the 
next step desired and place it in 
the folder as the last file. 

Links are provided to take 
students to the next page of 
content in the objective or 
module. 

Yes. No. Students would have to 
click on each file within the 
folder. 

Files can be easily uploaded en 
masse. 

No. Files are uploaded one at a 
time; no WebDAV capabilities; files 
are not stored in the Resources 
area. 

Yes. Multiple files can be easily 
uploaded using WebDAV. 

Links to Tests and Assignments 
can be added. 

Yes, eventually. This capability 
may be present in the next 
version of Laulima. 

No. 

Can conditionally release 
learning pathway based upon 
grades in the testing tool. 

Yes, eventually.  This capability 
may be present in the next 
version of Laulima. 

No. 
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CREATING A FILE STRUCTURE 

The next thing to do is organize your files, using the layout from your storyboard or hierarchical chart, so that 
they can be easily located. This will also be extremely useful when you are ready to upload the content to the 
Resources area and use it within Laulima. 

EXERCISE – CREATING A COURSE FOLDER 

1. On your desktop, or in a location appropriate to you such as My Documents, right-click on your mouse. 

 An alternative menu will open. 

2. Click on New, and then click Folder. 

 A new untitled folder will appear. 

3. Give the new folder the name of your course (ex: ED314). 

4. Double-click on the newly created folder 
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EXERCISE – CREATING A COURSE FOLDER (CONT’D) 

5. Repeat steps 1 – 3 of this exercise within this new course folder to create folders that match your course 
objectives and learning pathways, naming them appropriately. 

 Examples: Syllabus, Unit1, Chapter1, or Week1, etc. 

 IMPORTANT NOTE:  Do not use spaces in any of your folder or file names, as some content 
management systems will not accept them. 

6. Repeat steps 1 – 3 of this exercise within each new course objective folder to create folders that match the 
specific content that you use for that objective. 

 Examples: Lessons, Lectures, Assignments, Resources 

 Note: Try to stay consistent with organization and content within each objective or learning pathway 
throughout your course. 

UNIT 3: CONVERTING CONTENT FOR USE ONLINE 

For online course content, HTML is the preferred format because the student doesn’t require any special 
software applications or browser plug-ins. However, most instructors only have Microsoft Word or other word 
processor-related files. Unfortunately, when these Word files are converted to HTML they don’t always look as 
intended. Also, Office adds Office-specific markup to the standard Hypertext Markup Language (HTML), which 
increases the HTML file size considerably. As an alternative, it is better to copy and paste content from your 
Word document into Laulima’s built-in HTML editors. This option will also make editing easier in the future 
when changes are required. 

In the case of PowerPoint files, it is best to use Laulima’s Presentation tool, save the presentation as a PDF 
file, or use Microsoft’s Save As Webpage feature. This is because not all students have the ability to view a 
native PowerPoint presentation (i.e., they don’t have PowerPoint, the PowerPoint viewer, or other capable 
application). Thus, they will not be able to view your presentation. 

To learn how to use Laulima’s Presentation tool or to save the presentation as a web page, please see these 
tutorials: 

Presentation Tool - http://www.hawaii.edu/talent/webctfacultysupport/tutorials_laulimapresentations.htm 

Save as Web Page - http://www.hawaii.edu/talent/webctfacultysupport/tutorials_pptwindows.htm 

EXERCISE 1 – LOGGING ON TO LAULIMA 

1. Open the browser of your choice. 

2. In the URL address or location field, enter the Laulima server address: https://laulima.hawaii.edu/portal. 

3. In the top right-hand corner of the browser window, click on the Login link. 

4. Enter your UH user ID and password, then click the Login button. 

 The My Workspace screen will open. 

 In the My Workspace area in the blue course tabs bar at the top of the page, click on link for the 
course you wish to work with and the Homepage appears. 
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EXERCISE 2 – EASILY CONVERTING WORD CONTENT TO HTML IN LAULIMA 

In this exercise the Syllabus tool will be used for the example, however, the technique shown in this exercise 
works similarly in other Laulima tools where the built-in HTML editor is present (such as Announcements, 
Assignments, etc.): 

1. On the Homepage, on the left-hand side menu bar, click on the Syllabus link. 

 The Syllabus screen appears. 

2. Click on the Create/Edit link, and then click the Add link. 

 The Add syllabus screen appears. 

3. In the Title field, enter Welcome to Class. 

 Note: The title can be for the entire syllabus or for just a section (ex: ED314: Pre-service Education or 
Welcome to Class) 

4. Open the Syllabus.doc file (or your own syllabus file) located on the desktop in Word. 

5. With the cursor, highlight the text under Welcome to Class. 

 Note: You can copy the first topic, section, main paragraph, or the entire syllabus, depending upon 
how you want your syllabus to appear. 

6. Go to the Edit menu, and then choose Copy.  

7. In Laulima, click within the content area of the HTML editor, and then click the Paste from Word icon  

 The Paste from Word text box appears 

8. Click in the text box, and then press Ctrl + v (or Cmd ⌘ + v on a Mac) to paste the copied text. 

 Using Ctrl + v (or Cmd ⌘ + v) to paste is the best method for preserving the formatting of the original 
Word document. 

 However, if your syllabus contains complex formatting, such as tables and images, you may want to 
instead attach it as a PDF file. 

9. Click the OK button. 

 The Add syllabus screen reappears. 

10. Click the Post button. 

 Note: If you are adding individual sections, click the Add button and repeat steps 5 – 10 of this 
exercise 

11. When finished adding syllabus items, click the Update button. 
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EXERCISE 3 – CONVERTING CONTENT TO PDF 

If your Word document contains complex formatting, such as tables and images, or you have a PowerPoint 
presentation, you may want to convert it to a PDF file. Depending upon the browser used, students will either 
see the PDF file directly in their browser window, or they will be prompted to download it where it will then be 
opened by the student’s application of choice (i.e., Acrobat Reader, etc.). 

To convert content to PDF you will need a PDF writer such as: 

 the full version of Adobe Acrobat (not the Reader!), or 

 any number of free applications such as CutePDF Writer (Windows only), or 

 the PDF writer built-in to the Mac operating system. To do so: 

• Go to the File menu, and then choose Print. 

• From the PDF drop-down list, select Save as PDF. 

• Verify the file name and save location, and then click the Save button. 

For convenience, this exercise will use CutePDF Writer, which can be downloaded for free at 
http://www.cutepdf.com/Products/CutePDF/writer.asp. Follow their instructions on how to download and install 
CutePDF Writer and the required PS2PDF Converter. 

1. Open the WordExer.doc file (or your own file) located on the desktop. 

2. Go to the File menu, and then choose Print. 

 The print dialog box will appear. 

3. From the printer Name drop-down list, choose CutePDF Writer, then click the OK button 

 The Save As dialog box will appear. 

4. From the Save in drop-down list, navigate to the Lessons folder within the course folder on the desktop, 
or to the appropriate folder within your course folder on your computer. 

5. Verify that the file name is correct, changing it if necessary. 

6. Click the OK button. 

 The PDF file has been created. 

UNIT 4: MANAGING FILES IN LAULIMA 

Before content can be used in your course, the files must be uploaded to your course’s file management, or 
Resources, area on the server. Folders can be created and files can be uploaded one at a time or in batches 
using WebDAV. Once files are uploaded they can be moved, renamed, and edited within Laulima. 
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CREATING FOLDERS AND UPLOADING INDIVIDUAL FILES 

EXERCISE 1 – CREATING FOLDERS 

1. In Laulima, on the left-hand side menu bar, click on the Resources link 

 The Resources screen appears. 

2. Next to the course’s main folder, rollover Add, and click the Create Folders link. 

 The Create Folders screen appears. 

3. In the Folder Name field, enter a name. 

4. To add a description, availability information, or to hide the folder click the Add details for this item link. 

5. To add another folder click the Add Another Folder link and repeat steps 3 & 4. 

6. When finished adding folders, click the Create Folders Now button 

EXERCISE 2 – UPLOADING INDIVIDUAL FILES ONE AT A TIME 

1. Next to the folder to which you want to add a file, rollover Add, and click the Upload Files link. 

 The Upload Files screen appears. 

2. Click the Browse button to find the file, and then click the Open button. 

3. In the Display Name field, change the display name, if desired. 

 The file’s name is entered by default. 

4. To add a description, copyright status/alert, and availability information, click the Add details for this item 
link. 

5. To add another file click the Add Another File link and repeat steps 3 – 5. 

 You can only upload 60 MB worth of files at one time. You may need to upload large files one at a 
time. 

6. When finished adding files, click the Upload Files Now button. 

UPLOADING MULTIPLE FOLDERS AND FILES 

As you already know, files can be uploaded one at a time. However, if you have a large number of files this 
can become quite tedious and frustrating. Also, if you already have folders organized and created on your 
computer it can be a waste of time to re-create this organization in Resources. The best option is to set up a 
WebDAV connection that allows for multiple files/folder uploading. 

Depending on your Windows version (2000, XP, or Vista), accessing Internet Connections may differ but the 
process of creating the connection will be the same. 

NOTE: To connect using WebDAV on Vista you MUST download and install the following Windows Update 
from Microsoft: http://support.microsoft.com/?kbid=907306  
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Macintosh users can utilize this same technology by downloading "Goliath" from http://www.webDAV.org (from 
the left-hand menu click on the link for "Goliath", then choose "Download"), or if running Jaguar and above 
using the "Connect to Server" feature. 

EXERCISE 3 – CREATING A WEBDAV CONNECTION - WINDOWS 

1. In Laulima, on the left-hand side menu bar, click on the Resources link 

 The Resources screen appears. 

2. At the top of the screen, click the Upload-Download Multiple Resources link. 

 The Upload-Download Multiple Resources screen appears. 

3. For Windows XP using Internet Explorer, click the available link under the heading, "If you are using 
Internet Explorer in Windows XP….” 

 A connection dialog box will appear. 

 For directional information on how to upload using Vista and Macintosh operating systems, continue to 
scroll down the Laulima screen.  

4. Enter your UH username and password, then click the OK button. 

 WebDAV will connect with the Resources folder in this particular Laulima course allowing you to 
drag/drop files/folders into the opened WebDAV window for uploading. 

5. Once files have been uploaded you can close the WebDAV window. 

MANAGING FILES IN THE RESOURCES AREA 

Once files and folders are uploaded to the Resources area you may have the need to move, delete, or edit 
them at some point. 

EXERCISE 4 – MOVING A FILE OR FOLDER 

1. In Laulima, on the left-hand side menu bar, click on the Resources link (if not already there). 

 The Resources screen appears. 

2. To the right of the file or folder, rollover Actions, and click the Move link. 

 To move several items at a time, mark their corresponding checkboxes, and then, above the list of 
items, click Move link 

3. Navigate to the location where you wish to move the file or folder, and then click the Paste here icon  
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EXERCISE 5 – DELETING A FILE OR FOLDER 

1. In Laulima, on the left-hand side menu bar, click on the Resources link (if not already there). 

 The Resources screen appears. 

2. To the right of the file or folder, rollover Actions, and click the Remove link. 

 The Remove confirmation screen appears. 

3. Click the Remove or Cancel button. 

EXERCISE 6 – EDITING A FILE’S DETAILS OR CONTENT 

You can edit the name, description, or availability and access settings for a file or folder. You can also edit 
some of your files from within the Resources area using Laulima’s built-in editor. These files include HTML and 
text documents (.txt). 

Note: Online editing does not apply to Word (.doc), PowerPoint (.ppt), Rich Text Format (.rtf), or Portable 
Document Format (.pdf) files. Editing these files types will have to be done outside of Laulima, and then the 
new version will need to be uploaded. 

1. In Laulima, on the left-hand side menu bar, click on the Resources link (if not already there) 

 The Resources screen appears. 

2. To the right of a folder or an editable file, rollover Actions, click the desired action: 

 To edit the file or folder’s details click the Edit Details link. 

• The Edit Details screen appears. 

• Make the desired changes, and then click the Update button. 

 To edit the file’s content click the Edit Content link. 

• An editing screen will appear 

• Make desired changes, and then click the Continue button. 

Conclusion of Workshop’s Activities 

 Questions and answers or clarifications about workshop content 

 Have your expectations been met? 

 Completion of a workshop evaluation 

The module is complete. 
 
 
 
 
 
 
 



Working with Content for Use in Online Courses 

 Page 12 of 12 As of 3/13/08 

HELPFUL RESOURCES: 

 For assistance, call me at 933-3226, send email to cynthiae@hawaii.edu, or come by the Instructional 
Technology Lab in UCB 120. Lab hours: Monday through Friday, 8:00 to 5:00 (usually closed from 
noon to 1:00). 

 Laulima tutorials - http://www.hawaii.edu/talent/webctfacultysupport/tutorials.htm. To access the 
tutorials specifically used in this workshop go to: 

• Using the Laulima Presentation Tool - 
http://www.hawaii.edu/talent/webctfacultysupport/tutorials_laulimapresentations.htm 

• PowerPoint Presentation Save as Web Page - 
http://www.hawaii.edu/talent/webctfacultysupport/tutorials_pptwindows.htm 

 Laulima @ UHH Community Weblog – This blog is intended to provide up-to-date information. 
http://weblog.uhh.hawaii.edu/weblog/laulima/ 

 To download the free CutePDF Writer and the required converter go to: 
http://www.cutepdf.com/Products/CutePDF/writer.asp 


